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Introduction
The Xilinx® LogiCORE™ IP Debug Bridge core is 
a controller which provides a mechanism to 
establish a communication channel for debug 
cores with runtime software. The Debug Bridge 
usage can be classified into two categories: 
Tandem with Field Updates and Xilinx Virtual 
Cable (XVC). These two categories provide the 
means for communicating with the debug IP 
(including Memory IP) that is in the design. 

The Tandem with Field Updates flow allows you 
to download new functionality into a device 
over the PCIe® link after the device is initially 
configured through the Tandem PROM/PCIe. 
The XVC flow allows you to use debug cores 
and debug the design over non-JTAG interface 
(for example, Ethernet/PCIe).

Note: The current version is for the Tandem with 
Field Updates solution, Partial Reconfiguration 
design debugging, and XVC based designs. 

Features
There are two broad classification of Debug 
Bridge IP functionality, which are supported 
using six different modes.

• Tandem with Field Updates and Partial 
Reconfiguration Solution – User 
selectable mode From_BSCAN_to_Debug 
is used to add a Debug Bridge instance in 
each Reconfigurable Module which would 
connect to debug cores like ILA, VIO, 
Memory IP, and JTAG2AXI

• XVC Solution – Five modes are supported:

° User selectable mode 
From_AXI_to_BSCAN is used to add a 
Debug Bridge instance in the design 
with an Ethernet/PCIe master. This 
mode is a slave to Ethernet/PCIe master 
while connecting to debug cores like 
ILA, VIO, Memory IP, and JTAG2AXI in 
the same chip.

° User selectable mode 
From_AXI_to_JTAG is used to add a 
Debug Bridge instance in the design 
with an Ethernet/PCIe master. This 
mode is a slave to Ethernet/PCIe master 
while bringing out the JTAG pins out of 
the FPGA through I/O pins. This mode is 
mainly used to debug design on 
another board over XVC.

° User selectable mode 
From_JTAG_to_BSCAN is used to add a 
Debug Bridge instance to debug the 
designs over soft Test Access Port (TAP) 
controller.

° The following modes are only available 
for UltraScale+™ and UltraScale™ 
device architectures: 
- User selectable mode 

From_PCIE_to_BSCAN is used to 
add a Debug Bridge instance in the 
design with a PCIe master. This 
mode is a slave connected on the 
Extended Config interface to a PCIe 
master while connecting to debug 
cores like ILA, VIO, Memory IP, and 
JTAG2AXI in the same chip.

IP Facts
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IP Facts

- User selectable mode 
From_PCIE_to_JTAG is used to add 
a Debug Bridge instance in the 
design with a PCIe master. This 
mode is a slave connected on the 
Extended Config interface to a PCIe 
master while bringing out the JTAG 
pins out of the FPGA through I/O 
pins. This mode is mainly used to 
debug design on another board over 
XVC. 

• XVC in Partial Reconfiguration Solution – 
Option to add Debug Bridge in any XVC 
modes in the Partial Reconfiguration 
region. The XVC solution is used with a PCIe 
master or any AXI master. If the master is in 
a hang situation, there are no method to 
debug those scenarios. To provide a 
fallback debug path for XVC based design, 
a new mode is introduced: 
BSCAN_Primitive. In this mode, a BSCAN 
primitive can be instantiated in static 
region and BSCAN interface can be 
connected to the Debug Bridge in Partial 
Reconfiguration region providing a parallel 
path for debugging.

LogiCORE™ IP Facts Table
Core Specifics

Supported 
Device Family(1) UltraScale+™, UltraScale™, 7 Series

Supported User 
Interfaces IEEE Standard 1149.1 – JTAG

Resources Performance and Resource Utilization web page
Provided with Core

Design Files Register Transfer Level (RTL)
Example Design Verilog
Test Bench Not Provided
Constraints File Xilinx Design Constraints (XDC)
Simulation 
Model Not Provided

Supported 
S/W Driver Not Provided

Tested Design Flows(2)

Design Entry Vivado® Design Suite, Verilog, VHDL
Simulation Not Provided
Synthesis Vivado Synthesis

Support
Provided by Xilinx at the Xilinx Support web page

Notes: 
1. For a complete list of supported devices, see the Vivado IP 

catalog.
2. For the supported versions of the tools, see the

Xilinx Design Tools: Release Notes Guide.
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Chapter 1

Overview
The Xilinx® Debug Bridge IP core establishes the communication channel between the host 
machine and debug cores inside a Reconfigurable Module (RM) region through a Static 
region. The debug bridge needs to be instantiated in the RM with a BSCAN interface 
defined at the Partial Reconfiguration (PR) boundary. 

The Xilinx Debug Bridge IP core establishes the communication channel between the host 
machine and debug cores in both Tandem with Field Updates, Partial Reconfiguration based 
and Xilinx Virtual Cable (XVC) based designs. The following six modes describe the usage of 
the Debug Bridge for various designs.

Tandem with Field Updates and Partial 
Reconfiguration Solution
The From_BSCAN_to_DebugHub mode is used to create a Debug Bridge instance that 
must be placed in each Reconfigurable Module. This IP connects to debug cores like ILA, 
VIO, Memory IP, and JTAG2AXI. As of Vivado® Design Suite 2017.1, this connectivity 
between debug components in static and reconfigurable parts of the design is done 
automatically. Direct instantiation of this core should only be done as a backup 
methodology in the case that the Debug Hub inference methodology cannot be used. 

For further information on use of the Debug Bridge Partial Reconfiguration designs, see the 
Vivado Design Suite User Guide: Partial Reconfiguration (UG909) [Ref 2].
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Chapter 1: Overview

Figure 1-1 and Figure 1-2 show the mode used to add a Debug Bridge instance in each 
Reconfigurable Module.  

Xilinx Virtual Cable
The From_AXI_to_BSCAN mode is used to add a Debug Bridge instance in the design with 
an Ethernet/PCIe® master. This mode of Debug Bridge is a slave to Ethernet/PCIe master 
while connecting to debug cores like ILA, VIO, Memory IP, and JTAG2AXI in the same chip.

Figure 1-3 and Figure 1-4 show the From_AXI_to_BSCAN mode in the XVC use case. 

X-Ref Target - Figure 1-1

Figure 1-1: From_BSCAN_to_DebugHub Mode Port Diagram
X-Ref Target - Figure 1-2

Figure 1-2: Debug Bridge Configured with From_BSCAN_to_DebugHub Mode
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X-Ref Target - Figure 1-3

Figure 1-3: From_AXI_to_BSCAN Mode Port Diagram
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The From_AXI_to_JTAG mode is used to add a Debug Bridge instance in the design with an 
Ethernet/PCIe master. This mode of Debug Bridge is a slave to Ethernet/PCIe master while 
bringing out the JTAG pins out of the FPGA through I/O pins. This mode is mainly used to 
debug design on another board over XVC.

Figure 1-5 and Figure 1-6 show the From_AXI_to_JTAG mode in the XVC use case.  

The From_JTAG_to_BSCAN mode is used to add a Debug Bridge instance to debug the 
designs over soft Test Access Port (TAP) controller.

X-Ref Target - Figure 1-4

Figure 1-4: Debug Bridge Configured From_AXI_to_BSCAN Mode

Debug Bridge
(From AXI to BSCAN) Debug Hub

FPGA or SoC

BSCAN

Debug Core 1

Debug Core n

AXI Master AXIEthernet

X17933-083117
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Figure 1-5: From_AXI_to_JTAG Mode Port Diagram
X-Ref Target - Figure 1-6

Figure 1-6: Debug Bridge Configured From_AXI_to_JTAG Mode
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Chapter 1: Overview

Figure 1-7 and Figure 1-8 show the From_JTAG_to_BSCAN mode in the XVC use case.  

The From_PCIE_to_BSCAN mode is used to add a Debug Bridge instance in the design with 
a PCIe master. This Debug Bridge mode is a slave connected on the Extended Config 
interface to a PCIe master to debug cores like ILA, VIO, Memory IP, and JTAG2AXI in the 
same chip.

Figure 1-9 and Figure 1-10 show the From_PCIE_to_BSCAN mode in the XVC use case.  

X-Ref Target - Figure 1-7

Figure 1-7: From_JTAG_to_BSCAN Mode Port Diagram
X-Ref Target - Figure 1-8

Figure 1-8: Debug Bridge Configured From_JTAG_to_BSCAN Mode
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Figure 1-9: From_PCIE_to_BSCAN Mode Port Diagram
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Chapter 1: Overview

The From_PCIE_to_JTAG mode is used to add a Debug Bridge instance in the design with 
a PCIe master. This mode is a slave connected on the Extended Config interface to a PCIe 
master while bringing out the JTAG pins out of the FPGA through I/O pins. This mode is 
mainly used to debug design on another board over XVC.

Figure 1-11 and Figure 1-12 show the From_PCIE_to_JTAG mode in the XVC use case.  

X-Ref Target - Figure 1-10

Figure 1-10: Debug Bridge Configured From_PCIE_to_BSCAN Mode
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Figure 1-11: From_PCIE_to_JTAG Mode Port Diagram
X-Ref Target - Figure 1-12

Figure 1-12: Debug Bridge Configured From_PCIE_to_JTAG Mode
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Chapter 1: Overview

The BSCAN_Primitive mode is used to add a BSCAN Primitive in static region. This provides 
a BSCAN interface coming out from the BSCAN primitive and can be connected to 16 
different BSCAN slaves. 

Licensing and Ordering
This Xilinx LogiCORE™ IP module is provided at no additional cost with the Xilinx Vivado 
Design Suite under the terms of the Xilinx End User License. 

Information about other Xilinx LogiCORE IP modules is available at the Xilinx Intellectual 
Property page. For information on pricing and availability of other Xilinx LogiCORE IP 
modules and tools, contact your local Xilinx sales representative.

License Checkers
If the IP requires a license key, the key must be verified. The Vivado® design tools have 
several license checkpoints for gating licensed IP through the flow. If the license check 
succeeds, the IP can continue generation. Otherwise, generation halts with error. License 
checkpoints are enforced by the following tools:

• Vivado synthesis
• Vivado implementation
• write_bitstream (Tcl command)

X-Ref Target - Figure 1-13

Figure 1-13: Debug Bridge Configured BSCAN_Primitive Mode
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IMPORTANT: IP license level is ignored at checkpoints. The test confirms a valid license exists. It does 
not check IP license level.
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Chapter 2

Product Specification

Performance
The Debug Bridge core can be configured in two modes which caters the needs for 
debugging the designs for Tandem with Field Updates.

For full details about performance and resource utilization, visit the Performance and 
Resource Utilization web page.

Resource Utilization
For full details about performance and resource utilization, visit the Performance and 
Resource Utilization web page.

Port Descriptions
Table 2-1 and Table 2-7 show the signals for the different bridge type modes. 
Table 2-1: From BSCAN to DebugHub Mode

Signal I/O Description

clk Input clock to drive 
DebugHub logic

This port needs to connect to a free running clock available 
in the design.

S_BSCAN BSCAN slave interface 
(with BSCANID_EN)

This slave interface needs to connect to the BSCAN interface 
of a BSCAN master. (When C_BSCANID_VEC = 0).

S_BSCAN_VEC BSCAN slave interface 
(with BSCANID as 32-bit)

This slave interface needs to connect to the BSCAN interface 
of a BSCAN master. (When C_BSCANID_VEC = 1).

m<x>_bscan
BSCAN master interface

** x - integer value 
ranges from 0 to 15

This master interface needs to connect to BSCAN interface 
of a BSCAN master. For example, MDM and Debug_Bridge 
(with C_DEBUG_MODE = 1).
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Chapter 2: Product Specification

 

Table 2-2: From AXI4 to BSCAN Mode
Signal I/O Description

S_AXI AXI4-Lite slave 
interface This interface needs to connect to an AXI4.

s_axi_aclk I This port needs to connect to an AXI4 clock pin.
s_axi_aresetn I This port needs to connect to an AXI4 reset pin.

m<x>_bscan

BSCAN master 
interface

** x - integer 
value ranges from 

0 to 15

This master interface needs to connect to BSCAN interface of a 
BSCAN master. For example, MDM and Debug_Bridge (with 
C_DEBUG_MODE = 1).

Table 2-3: From AXI4 to JTAG Mode
Signal I/O Description

S_AXI AXI4-Lite slave 
interface This interface needs to connect to an AXI4.

s_axi_aclk I This port needs to connect to the AXI4 clk pin.
s_axi_aresetn I This port needs to connect to the AXI4 reset pin.
tap_tdo I This port needs to connect to TDO pin of JTAG slave.
tap_tdi O This port needs to connect to TDI pin of JTAG slave.
tap_tck O This port needs to connect to TCK pin of JTAG slave.
tap_tms O This port needs to connect to TMS pin of JTAG slave.

Table 2-4: From JTAG to BSCAN Mode
Signal I/O Description

jtag_tdo O This port needs to connect to TDO pin of JTAG master.
jtag_tdi I This port needs to connect to TDI pin of JTAG master.
jtag_tck I This port needs to connect to TCK pin of JTAG master.
jtag_tms I This port needs to connect to TMS pin of JTAG master.

Table 2-5: From PCIe to BSCAN Mode
Signal I/O Description

clk Input clock to drive 
DebugHub logic

This port needs to connect to a free running clock available 
in the design.

pcie3_cfg_ext PCIe® Extended Config 
slave interface

This slave interface needs to connect to PCIe extended 
config master interface.

m<x>_bscan
BSCAN master interface

** x - integer value 
ranges from 0 to 15

This master interface needs to connect to BSCAN interface 
of a BSCAN master. For example, MDM and Debug_Bridge 
(with C_DEBUG_MODE = 1).
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Register Space
Table 2-8 shows the register set for AXI4-Lite to JTAG Controller. 

Table 2-6: From PCIe to JTAG Mode
Signal I/O Description

clk Input clock to drive 
DebugHub logic

This port needs to connect to a free running clock 
available in the design.

pcie3_cfg_ext PCIe Extended Config 
slave interface

This slave interface needs to connect to PCIe extended 
config master interface.

tap_tdi O This port needs to connect to TDI pin of JTAG slave.
tap_tdo I This port needs to connect to TDO pin of JTAG slave.
tap_tck O This port needs to connect to TCK pin of JTAG slave.
tap_tms O This port needs to connect to TMS pin of JTAG slave.

Table 2-7: BSCAN Primitive Mode
Signal I/O Description

m<x>_bscan
BSCAN master interface

** x - integer value 
ranges from 0 to 15

This master interface needs to connect to BSCAN 
interface of a BSCAN master. For example, MDM and 
Debug_Bridge (with C_DEBUG_MODE = 1).

Table 2-8: From BSCAN to DebugHub Mode
Address 
Offset Name Access 

Type Default Value Description

0x00 LENGTH R/W 0x00000000 Length of shift operation in bits
0x04 TMS_VECTOR R/W 0x00000000 Test Mode Select (TMS) Bit Vector
0x08 TDI_VECTOR R/W 0x00000000 Test Data In (TDI) Bit Vector
0x0C TDO_VECTOR R/W 0x00000000 Test Data Out (TDO) Capture Vector

0x10 CTRL R/W 0x00000000
Bit 0: Enable shift operation
Bit 1: Control bit to loopback TDI to TDO 
inside Debug Bridge IP
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Chapter 3

Designing with the Core
This chapter includes guidelines and additional information to facilitate designing with the 
core. 

Clocking
The clk input port in the From_BSCAN_to_DebugHub mode needs to be connected to a 
free running clock available in the design. This clock is used by Debug Hub.

Resets
There are no resets for this IP core.
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Chapter 4

Design Flow Steps
This chapter describes customizing and generating the core, constraining the core, and the 
simulation, synthesis and implementation steps that are specific to this IP core. More 
detailed information about the standard Vivado® design flows and the IP integrator can be 
found in the following Vivado Design Suite user guides:

• Vivado Design Suite User Guide: Designing IP Subsystems using IP Integrator (UG994) 
[Ref 3]

• Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 4]
• Vivado Design Suite User Guide: Getting Started (UG910) [Ref 5]
• Vivado Design Suite User Guide: Logic Simulation (UG900) [Ref 6]

Customizing and Generating the Core
This section includes information about using Xilinx tools to customize and generate the 
core in the Vivado Design Suite.

If you are customizing and generating the core in the Vivado IP integrator, see the Vivado 
Design Suite User Guide: Designing IP Subsystems using IP Integrator (UG994) [Ref 3] for 
detailed information. IP integrator might auto-compute certain configuration values when 
validating or generating the design. To check whether the values do change, see the 
description of the parameter in this chapter. To view the parameter value, run the 
validate_bd_design command in the Tcl console.

You can customize the IP for use in your design by specifying values for the various 
parameters associated with the IP core using the following steps:

1. Open a project by selecting File > Open Project or create a new project by selecting 
File > New Project in Vivado. 

2. Select the Debug Bridge IP from the Debug & Verification > Debug > Debug Bridge 
in Vivado IP catalog.

3. Double-click the selected IP or select the Customize IP command from the toolbar or 
right-click menu.
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For details, see the Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 4] and 
the Vivado Design Suite User Guide: Getting Started (UG910) [Ref 5].

Note: Figure in this chapter is an illustration of the Vivado Integrated Design Environment (IDE). The 
layout depicted here might vary from the current version.

General Options Panel
Figure 4-1 shows the Debug Bridge Vivado IDE main configuration screen. 

• Component Name – Use this text field to provide a unique module name for the 
Debug Bridge core.

• Design Type – Use this option to choose which design environment the Debug Bridge 
is instantiated in.

• Debug Bridge Options – This option switches between seven different modes:

° From_BSCAN_to_DebugHub

° From_AXI_to_BSCAN

X-Ref Target - Figure 4-1

Figure 4-1: Debug Bridge Customize IP – Debug Modes
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° From_AXI_to_JTAG

° From_JTAG_to_BSCAN

° From_PCIE_to_BSCAN

° From_PCIE_to_JTAG

° BSCAN_Primitive

Figure 4-2 shows the Debug Bridge Vivado IDE configuration BSCAN Options tab for the 
From_BSCAN_to_DebugHub mode. 

• BSCAN Master Port Options 

° BSCAN Master Count – This option specifies the number of BSCAN master 
interfaces enabled on the Debug Bridge instance. Minimum = 0 to Maximum = 16.

X-Ref Target - Figure 4-2

Figure 4-2: Debug Bridge Customize IP – BSCAN Options
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Figure 4-3 shows the Debug Bridge Vivado IDE configuration DebugHub Options tab for 
the From_BSCAN_to_DebugHub mode. 

• Clock Divider Options – These options show the address width, data width, and clock 
ratio settings.

° Enable Clock Divider – Divides down the clock frequency on the clk port to 
100 MHz. Enabling this option, Clock Frequency option is visible to enter the 
frequency value of the clock connect to clk port.

X-Ref Target - Figure 4-3

Figure 4-3: Debug Bridge Customize IP – DebugHub Options

Send Feedback

https://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=Product_Guide&docId=PG245&Title=Debug%20Bridge%20v3.0&releaseVersion=3.0&docPage=20


Debug Bridge v3.0 21
PG245 December 5, 2018 www.xilinx.com

Chapter 4: Design Flow Steps

Figure 4-4 shows the Debug Bridge Vivado IDE configuration for the From_AXI_to_BSCAN 
mode. 

X-Ref Target - Figure 4-4

Figure 4-4: Debug Bridge Customize IP – From AXI to BSCAN Mode
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Figure 4-5 shows the Debug Bridge Vivado IDE configuration BSCAN Options tab for the 
From_AXI_to_BSCAN mode. 

• JTAG Fallback Options
° JTAG Fallback Mode – This option enables the parallel JTAG path for enabling 

debug path when XVC channel is in a hang state. There are three different options:
- DISABLED – JTAG Fallback mode is disabled. There is no parallel JTAG path.
- Internal BSCAN Primitive – BSCAN primitive is instantiated inside the Debug 

Bridge instance itself. (This option is seen only when the Design Type is set to 
static region).

- External BSCAN Master – BSCAN master is external.
• BSCAN Master Port Options 

° BSCAN Master Count – This option specifies the number of BSCAN master 
interfaces enabled on the Debug Bridge instance. Minimum = 0 to Maximum = 16.

X-Ref Target - Figure 4-5

Figure 4-5: Debug Bridge Customize IP – From AXI to BSCAN Mode BSCAN Options
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Figure 4-6 shows the Debug Bridge Vivado IDE configuration for the From_AXI_to_JTAG 
mode. 

X-Ref Target - Figure 4-6

Figure 4-6: Debug Bridge Customize IP – From AXI to JTAG Mode
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Figure 4-7 shows the Debug Bridge Vivado IDE configuration for the 
From_JTAG_to_BSCAN mode. 

X-Ref Target - Figure 4-7

Figure 4-7: Debug Bridge Customize IP – From JTAG to BSCAN Mode
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Figure 4-8 shows the Debug Bridge Vivado IDE configuration BSCAN Options tab for the 
From_JTAG_to_BSCAN mode. 

• BSCAN Master Port Options 
° BSCAN Master Count – This option specifies the number of BSCAN master 

interfaces enabled on the Debug Bridge instance. Minimum = 0 to Maximum = 16.

X-Ref Target - Figure 4-8

Figure 4-8: Debug Bridge Customize IP – From JTAG to BSCAN Mode BSCAN Options
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Figure 4-9 shows the Debug Bridge Vivado IDE configuration screen for the 
From_PCIE_to_BSCAN mode. 

X-Ref Target - Figure 4-9

Figure 4-9: Debug Bridge Customize IP – From PCIE to BSCAN Mode
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Figure 4-10 shows the Debug Bridge Vivado IDE configuration BSCAN Options tab for the 
From_PCIE_to_BSCAN mode. 

• JTAG Fallback Options
° JTAG Fallback Mode – This option enables the parallel JTAG path for enabling 

debug path when XVC channel is in a hang state. There are three different options:
- DISABLED – JTAG Fallback mode is disabled. There is no parallel JTAG path.
- Internal BSCAN Primitive – BSCAN primitive is instantiated inside the Debug 

Bridge instance itself. (This option is seen only when the Design Type is set to 
static region).

- External BSCAN Master – BSCAN master is external.
• BSCAN Master Port Options 

° BSCAN Master Count – This option specifies the number of BSCAN master 
interfaces enabled on the Debug Bridge instance. Minimum = 0 to Maximum = 16.

X-Ref Target - Figure 4-10

Figure 4-10: Debug Bridge Customize IP – From PCIE to BSCAN Mode BSCAN Options
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Figure 4-11 shows the Debug Bridge Vivado IDE configuration PCIE Options tab for the 
From_PCIE_to_BSCAN mode. 

• PCIE Options – These options show the PCIe® VSEC parameters required to set PCIe 
master to communicate with the Debug Bridge over the Extended config space.

° PCIe XVC VSEC Base Address – PCIe Extended Config Base address for the XVC 
VSEC.

IMPORTANT: This should fall within the valid range for the PCIe Extended Config space. See the 
relevant PCIe product guide for additional details.

° PCIe XVC VSEC Length – XVC VSEC length in bytes and this is a fixed length for 
XVC VSEC.

° PCIe XVC VSEC Next Pointer – XVC VSEC next capability offset pointer. This is set 
to the address offset of the next PCIe extended capability or set to 0x000 to 
terminate the extended capability chain.

X-Ref Target - Figure 4-11

Figure 4-11: Debug Bridge Customize IP – From PCIE to BSCAN Mode PCIE Options
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° PCIe XVC VSEC ID – XVC VSEC ID identifies the XVC extended capability. This value 
should be validated by the Host software to identify the XVC extended capability. 
This value should not be modified when using the Xilinx Vendor ID of 0x10EE for 
the corresponding PCIe IP configuration.

° PCIe XVC VSEC Rev ID – XVC VSEC Rev ID identifies the revision of the XVC 
extended capability. This value should be validated by the Host software to identify 
the XVC extended capability revision. This value should not be modified when using 
the Xilinx Vendor ID of 0x10EE for the corresponding PCIe IP configuration.

Figure 4-12 shows the Debug Bridge Vivado IDE configuration XVC Options tab for the 
From_PCIE_to_BSCAN mode. 

IMPORTANT: Xilinx recommends that the XVC Options are not modified. The customization GUI sets 
the desired XVC Hardware ID and XVC Software ID values.

X-Ref Target - Figure 4-12

Figure 4-12: Debug Bridge Customize IP – From PCIE to BSCAN Mode XVC Options
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• XVC Options – These options are for the PCIe driver and runtime tool to identify the 
XVC versions.

° XVC Hardware ID – Hardware ID value.

° XVC Software ID – Software ID value.

Figure 4-13 shows the Debug Bridge Vivado IDE configuration screen for the 
From_PCIE_to_JTAG mode. 

X-Ref Target - Figure 4-13

Figure 4-13: Debug Bridge Customize IP – From PCIE to JTAG Mode
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Figure 4-14 shows the Debug Bridge Vivado IDE configuration PCIE Options tab for the 
From_PCIE_to_JTAG mode. 

• PCIE Options – These options show the PCIe VSEC parameters required to set PCIe 
master to communicate with the Debug Bridge over the Extended config space.

° PCIe XVC VSEC Base Address – PCIe Extended Config Base address for the XVC 
VSEC.

IMPORTANT: This should fall within the valid range for the PCIe Extended Config space. See the 
relevant PCIe product guide for additional details.

° PCIe XVC VSEC Length – XVC VSEC length in bytes and this is a fixed length for 
XVC VSEC.

° PCIe XVC VSEC Next Pointer – XVC VSEC next capability offset pointer. This is set 
to the address offset of the next PCIe extended capability or set to 0x000 to 
terminate the extended capability chain.

X-Ref Target - Figure 4-14

Figure 4-14: Debug Bridge Customize IP – From PCIE to JTAG Mode PCIE Options
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° PCIe XVC VSEC ID – XVC VSEC ID identifies the XVC extended capability. This value 
should be validated by the Host software to identify the XVC extended capability. 
This value should not be modified when using the Xilinx Vendor ID of 0x10EE for 
the corresponding PCIe IP configuration.

° PCIe XVC VSEC Rev ID – XVC VSEC Rev ID identifies the revision of the XVC 
extended capability. This value should be validated by the Host software to identify 
the XVC extended capability revision. This value should not be modified when using 
the Xilinx Vendor ID of 0x10EE for the corresponding PCIe IP configuration.

Figure 4-15 shows the Debug Bridge Vivado IDE configuration XVC Options tab for the 
From_PCIE_to_JTAG mode.

IMPORTANT: Xilinx recommends that the XVC Options are not modified. The customization GUI sets 
the desired XVC Hardware ID and XVC Software ID values.

X-Ref Target - Figure 4-15

Figure 4-15: Debug Bridge Customize IP – From PCIE to JTAG Mode XVC Options
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• XVC Options – These options are for the PCIe driver and runtime tool to identify the 
XVC versions.

° XVC Hardware ID – Hardware ID value.

° XVC Software ID – Software ID value.

Figure 4-16 shows the Debug Bridge Vivado IDE configuration for the BSCAN_Primitive 
mode. 

X-Ref Target - Figure 4-16

Figure 4-16: Debug Bridge Customize IP – BSCAN Primitive Mode
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User Parameters
Table 4-1 shows the relationship between the fields in the Vivado IDE and the User 
Parameters (which can be viewed in the Tcl Console).

• Bridge Type – This parameter configures debug_bridge in seven different modes: 
From_BSCAN_to_DebugHub, From_AXI_to_BSCAN, From_AXI_to_JTAG, 
From_JTAG_to_BSCAN, From_PCIE_to_BSCAN, From_PCIE_to_JTAG, and 
BSCAN_Primitive.

° From_BSCAN_to_DebugHub – This mode is only used while instantiating the 
debug_bridge IP in the PR region. While adding this block to the PR region design 
part, the following pins need to be added as part of the PR boundary and also need 
to be connected to the debug_bridge instance: 

Table 4-1: Vivado IDE Parameter to User Parameter Relationship
Vivado IDE Parameter/Value(1) User Parameter/Value(1) Default Value

Bridge Type C_DEBUG_MODE From_BSCAN_to_DebugHub
Enable Clock Divider C_ENABLE_CLK_DIVIDER FALSE
Clock Frequency (In Hertz) C_CLK_INPUT_FREQ_HZ 300000000
AXI Addr Width C_S_AXI_ADDR_WIDTH 5
AXI Data Width C_S_AXI_DATA_WIDTH 32
Tck Clock Ratio C_TCK_CLOCK_RATIO 8
User Scan Chain C_USER_SCAN_CHAIN 1
Enable BSCANID Vector C_EN_BSCANID_VEC FALSE
PCIe XVC VSEC Base Address C_PCIE_EXT_CFG_BASE_ADDR 0x400
PCIe XVC VSEC Length C_PCIE_EXT_CFG_VSEC_LENGTH 0x020
PCIe XVC VSEC Next Pointer C_PCIE_EXT_CFG_NEXT_PTR 0x000
PCIe XVC VSEC ID C_PCIE_EXT_CFG_VSEC_ID 0x0008
PCIe XVC VSEC Rev ID C_PCIE_EXT_CFG_VSEC_REV_ID 0x0
XVC Hardware ID C_XVC_HW_ID 0x0001
XVC Software ID C_XVC_SW_ID 0x0001
Design Type C_DESIGN_TYPE Static Region 
BSCAN Master Count C_NUM_BS_MASTER 0
JTAG Fallback Mode C_BSCAN_MUX DISABLED

Notes: 
1. Parameter values are listed in the table where the Vivado IDE parameter value differs from the user parameter 

value. Such values are shown in this table as indented below the associated parameter.

Signal I/O
S_BSCAN Slave BSCAN Interface
S_BSCAN_VEC Slave BSCAN Interface
clk I
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In this mode, there is another clk port on debug_bridge which needs to be 
connected to a stable free running clock or one of the clock connected to a debug 
core in the PR region. There are two sub-parameters in this mode which qualify the 
clk port. 

° From_AXI_to_BSCAN – This mode is only used while debugging a design on the 
same FPGA over the Xilinx Virtual Cable (XVC). This block is connected as an AXI4 
slave to an AXI4 master.

° From_AXI_to_JTAG – This mode is only used while debugging a design on a 
different FPGA over the XVC. This block is connected as an AXI4 slave to an AXI4 
master. The following four JTAG ports are connected to I/Os so that they can be 
connected to JTAG pins of another board. 

° From_JTAG_to_BSCAN – This mode is only used while debugging over soft BSCAN 
where the JTAG connection is through regular I/Os. The following pins are 
connected to regular I/Os to connect to JTAG connector.

° From_PCIE_to_BSCAN – This mode is used to add a Debug Bridge instance in the 
design with a PCIe master. This mode is a slave connected on the Extended Config 
interface on the PCIe master to debug cores like ILA, VIO, Memory IP, and JTAG2AXI 
in the same chip. 

For more information on how to use the PCIe with the XVC, see the UltraScale 
Devices Gen3 Integrated Block for PCI Express LogiCORE IP Product Guide (PG156) 
[Ref 2].

Signal I/O
tap_tdo I
tap_tdi O
tap_tck O
tap_tms O

Signal I/O
jtag_tdo O
jtag_tdi I
jtag_tck I
jtag_tms I
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° From_PCIE_to_JTAG – This mode is used to add a Debug Bridge instance in the 
design with a PCIe master. This mode is a slave connected on the Extended Config 
interface on the PCIe master while bringing out the JTAG pins out of the FPGA 
through I/O pins. This mode is mainly used to debug design on another board over 
XVC.

° PCIe XVC VSEC Base Address – PCIe Extended Config Base address for the XVC 
VSEC.

IMPORTANT: This should fall within the valid range for the PCIe Extended Config space. See the 
relevant PCIe product guide for additional details.

• PCIe XVC VSEC Length – XVC VSEC length in bytes, this is a fixed length for XVC VSEC.
• PCIe XVC VSEC Next Pointer – XVC VSEC next capability offset pointer. This is set to 

the address offset of the next PCIe extended capability or set to 0x000 to terminate the 
extended capability chain.

• PCIe XVC VSEC ID – XVC VSEC ID identifies the XVC extended capability. This value 
should be validated by the Host software to identify the XVC extended capability. This 
value should not be modified when using the Xilinx Vendor ID of 0x10EE for the 
corresponding PCIe IP configuration.

• PCIe XVC VSEC Rev ID – XVC VSEC Rev ID identifies the revision of the XVC extended 
capability. This value should be validated by the Host software to identify the XVC 
extended capability revision. This value should not be modified when using the Xilinx 
Vendor ID of 0x10EE for the corresponding PCIe IP configuration.

• XVC HardWare ID – Hardware ID value.
• XVC SoftWare ID – Software ID value.
• Enable BSCANID Vector – This parameter uses the BSCANID 32-bit signal for 

backwards compatibility with the previous versions.
• Enable Clock Divider – This parameter is checked only when the clock frequency of the 

signal connected to the clk port is >100 MHz. This option divides down the clock 
frequency of clock at the clk port of debug_bridge to 100 MHz.

• Clock Frequency (in Hz) – This parameter is visible only when Enable Clock Divider 
options is enabled. The value of this parameter should be the frequency of the clock 
signal connected to the clk port of Debug Bridge instance in Hz.

Signal I/O
tap_tdo I
tap_tdi O
tap_tck O
tap_tms O
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• Design Type – This parameter specifies the type of user design in which the Debug 
Bridge is going to be instantiated. There are two types: Static region or RP region.

• BSCAN Master Count – This parameter sets the number of BSCAN master interfaces 
that should be coming out of Debug Bridge instance to connect to BSCAN slaves.

• JTAG Fallback Mode – This parameter enables the parallel JTAG path in the case of 
XVC designs.

Output Generation
For details, see the Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 4].

Constraining the Core
This section contains information about constraining the core in the Vivado Design Suite.

Required Constraints
This section is not applicable for this IP core.

Device, Package, and Speed Grade Selections
This IP supports Tandem with Field Updates and Xilinx Virtual Cable in UltraScale+™, 
UltraScale™, and 7 series devices and packages. Currently, only PCIe is supported in 
UltraScale+ and UltraScale devices.

Clock Frequencies
This section is not applicable for this IP core.

Clock Management
This section is not applicable for this IP core.

Clock Placement
This section is not applicable for this IP core.

Banking
This section is not applicable for this IP core.
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Transceiver Placement
This section is not applicable for this IP core.

I/O Standard and Placement
This section is not applicable for this IP core.

Simulation
This IP core does not support simulation.

Synthesis and Implementation
For details about synthesis and implementation, see the Vivado Design Suite User Guide: 
Designing with IP (UG896) [Ref 4].
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Test Bench
There is no test bench for this IP core release.
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Appendix A

Verification, Compliance, and 
Interoperability

This appendix provides details about how this IP core was tested for compliance with the 
protocol to which it was designed.

Xilinx® has verified the Debug Bridge core in a proprietary test environment, using an 
internally developed bus functional model.
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Appendix B

Upgrading
This appendix contains information about upgrading to a more recent version of the IP 
core. 

Upgrading in the Vivado Design Suite
This section provides information about any changes to the user logic or port designations 
between core versions.

Changes from v2.0 to v3.0
Added BSCAN_Primitive mode and XVC in Partial Reconfiguration Solution.

Changes from v1.1 to v2.0
Added From_PCIE_to_BSCAN and From_PCIE_to_JTAG modes with new PCIE Options and 
XVC Options.

Changes from v1.0 to v1.1
While upgrading the designs with debug_bridge_v1_0 to debug_bridge_v1_1, the 
following steps need to happen:

1. The Debug Bridge instance in BSCAN_Primitive mode in the static region of Tandem 
Field Updates design needs to be selected.

2. The Debug Bridge instance in From_BSCAN_to_DebugHub mode needs to be 
regenerated and the BSCAN pins crossing the PR boundary has to be expanded per 
latest version. These BSCAN pins on the Debug Bridge boundary of RM blocks need to 
ground for inputs and left unconnected for outputs.
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Appendix C

Debugging
This appendix includes details about resources available on the Xilinx Support website and 
debugging tools.

TIP: If the IP generation halts with an error, there might be a license issue. See License Checkers in 
Chapter 1 for more details.

Finding Help on Xilinx.com
To help in the design and debug process when using the Debug Bridge, the Xilinx Support 
web page contains key resources such as product documentation, release notes, answer 
records, information about known issues, and links for obtaining further product support.

Documentation
This product guide is the main document associated with the Debug Bridge. This guide, 
along with documentation related to all products that aid in the design process, can be 
found on the Xilinx Support web page or by using the Xilinx Documentation Navigator.

Download the Xilinx Documentation Navigator from the Downloads page. For more 
information about this tool and the features available, open the online help after 
installation.

Answer Records 
Answer Records include information about commonly encountered problems, helpful 
information on how to resolve these problems, and any known issues with a Xilinx product. 
Answer Records are created and maintained daily ensuring that users have access to the 
most accurate information available. 
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Answer Records for this core can be located by using the Search Support box on the main 
Xilinx support web page. To maximize your search results, use proper keywords such as:

• Product name
• Tool message(s)
• Summary of the issue encountered

A filter search is available after results are returned to further target the results.

Master Answer Record for the Debug Bridge

AR: 54606

Technical Support
Xilinx provides technical support at the Xilinx Support web page for this LogiCORE™ IP 
product when used as described in the product documentation. Xilinx cannot guarantee 
timing, functionality, or support if you do any of the following:

• Implement the solution in devices that are not defined in the documentation.
• Customize the solution beyond that allowed in the product documentation. 
• Change any section of the design labeled DO NOT MODIFY.

To contact Xilinx Technical Support, navigate to the Xilinx Support web page.

Debug Tools
There are many tools available to address Debug Bridge design issues. It is important to 
know which tools are useful for debugging various situations.

Vivado Design Suite Debug Feature
The Vivado® Design Suite debug feature inserts logic analyzer and virtual I/O cores directly 
into your design. The debug feature also allows you to set trigger conditions to capture 
application and integrated block port signals in hardware. Captured signals can then be 
analyzed. This feature in the Vivado IDE is used for logic debugging and validation of a 
design running in Xilinx devices.
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The Vivado logic analyzer is used with the logic debug IP cores, including:

• ILA 2.0 (and later versions)
• VIO 2.0 (and later versions)

See the Vivado Design Suite User Guide: Programming and Debugging (UG908) [Ref 7].
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Additional Resources and Legal Notices

Xilinx Resources
For support resources such as Answers, Documentation, Downloads, and Forums, see 
Xilinx Support. 

Documentation Navigator and Design Hubs
Xilinx® Documentation Navigator provides access to Xilinx documents, videos, and support 
resources, which you can filter and search to find information. To open the Xilinx 
Documentation Navigator (DocNav): 

• From the Vivado® IDE, select Help > Documentation and Tutorials.
• On Windows, select Start > All Programs > Xilinx Design Tools > DocNav.
• At the Linux command prompt, enter docnav.

Xilinx Design Hubs provide links to documentation organized by design tasks and other 
topics, which you can use to learn key concepts and address frequently asked questions. To 
access the Design Hubs:

• In the Xilinx Documentation Navigator, click the Design Hubs View tab.
• On the Xilinx website, see the Design Hubs page.
Note: For more information on Documentation Navigator, see the Documentation Navigator page 
on the Xilinx website.
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References
These documents provide supplemental material useful with this product guide:

1. Vivado Design Suite User Guide: Partial Reconfiguration (UG909)
2. UltraScale Devices Gen3 Integrated Block for PCI Express LogiCORE IP Product Guide 

(PG156)
3. Vivado Design Suite User Guide: Designing IP Subsystems using IP Integrator (UG994)
4. Vivado Design Suite User Guide: Designing with IP (UG896)
5. Vivado Design Suite User Guide: Getting Started (UG910)
6. Vivado Design Suite User Guide: Logic Simulation (UG900)
7. Vivado Design Suite User Guide: Programming and Debugging (UG908)
8. Vivado Design Suite User Guide: Implementation (UG904)

Revision History
The following table shows the revision history for this document. 

Date Version Revision
12/05/2018 3.0 • Added Register Space section.

• Fixed AR in Answer Records section.
10/04/2017 3.0 • Added XVC in Partial Reconfiguration Solution IP Facts section.

• Added BSCAN_Primitive description in Overview chapter.
• Added BSCAN to tables in Product Specification chapter.
• Updated Design Flow Steps chapter.

04/28/2017 2.0 • Updated Resources in IP Facts section.
• Updated Resource Utilization section.

04/05/2017 2.0 • Updated IP Facts section.
• Updated Overview chapter.
• Updated Device Utilization table.
• Updated Port Descriptions section.
• Updated description and figures in General Options Panel section.
• Updated User Parameter section.
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10/05/2016 1.1 • Updated IP Facts section.
• Updated Overview chapter.
• Updated Device Utilization table.
• Updated Port Descriptions section.
• Updated description and figures in General Options Panel section.
• Updated User Parameter section.
• Updated Upgrading appendix.

04/06/2016 1.0 Initial Xilinx release.

Date Version Revision
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Please Read: Important Legal Notices
The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the 
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS 
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF 
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether 
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related 
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, 
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a 
result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised 
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of 
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials 
without prior written consent. Certain products are subject to the terms and conditions of Xilinx’s limited warranty, please refer to 
Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and 
support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use 
in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical 
applications, please refer to Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.
AUTOMOTIVE APPLICATIONS DISCLAIMER
AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF 
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”) UNLESS THERE IS A 
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY 
DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY 
TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY 
AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT 
LIABILITY.
© Copyright 2016–2018 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated 
brands included herein are trademarks of Xilinx in the United States and other countries. PCI, PCIe, and PCI Express are trademarks 
of PCI-SIG and used under license. All other trademarks are the property of their respective owners.
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